Experiment HM-9: Kinesiology and Electromyogram (EMG) Activity in Targeted Muscles

Lab written in conjunction with:
Kelly Helm PhD, Director Exercise Science, Department of Kinesiology;
Amanda Ulin & Kelsey Draper, Seniors, Biology & Exercise Science; Valparaiso University,
Valparaiso, IN
Jennifer Rosene PT, MS; Plymouth, NH

Background
One of the biggest deterrents for those wanting to start exercising is that they simply don't know where to begin. The idea of targeted muscle training is to group muscles into working “units” and target their training specifically for the group of muscles. Exercises are then tailored to work the individual muscles in the group. By measuring electromyogram (EMG) activity or each of the muscles in the group, it is easy to tell if the muscle you want to be using is the one that is actually doing the work.
The easiest way to understand muscle movements is by the motion you must make to target and work that particular muscle or muscle group. The best way to simplify all of the movement patterns is to call them "push" or "pull" movements. "Push" movements describe any motion you must make to push the weight away from your body and "pull" movements are those motions you must make to pull the weight into your body. Certain muscle groups complement one another in that they require the same "push" or "pull" movement type to target the muscle.
An example of a "push" movement exercise is the bench press. This exercise is used to work the muscles in your chest but also incorporates your shoulders and triceps which are all "push" movement muscles. An example of a "pull" movement exercise is the bent-over row. This exercise is used to work the muscles in your back but also incorporates your biceps which are all "pull" movement muscles.
To make this easier to understand: "Push" movement body parts include: the muscles of the chest, shoulders, triceps, quadriceps (vastus muscles and rectus femoris), and the muscles in the calves. "Pull" movement body parts include: the muscle of the back, biceps, hamstrings (semimembranosus, semitendinosus and biceps femoris), and the abdominal muscles. It is important to note that there are exceptions and variations to these movements, especially in working the leg muscles. Leg muscles are large and are often worked using compound movements that incorporate the gluteus muscles, the quadriceps and the hamstrings.
This lab will allow the grouping of muscles, specifically those in the hip area, and target movements to exercise those individual muscles. Recording EMG activity while doing these exercises will give immediate feedback as to whether the muscle being targeted by a specific exercise is the one that is actually being used.
Any group of three muscles can be used for this lab and appropriate exercises for the targeted muscles can be found online and by speaking to the campus athletic trainer or physical therapist. The muscles that are easy to focus on would be the quadriceps or the hamstrings as an addition to this lab.
<table>
<thead>
<tr>
<th>Muscle Group</th>
<th>Location</th>
<th>Functional Role</th>
<th>Exercise to Strengthen</th>
<th>Sample Stretch</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abdominal</td>
<td>Stomach</td>
<td>Sitting up, postural alignment</td>
<td>Crunches, leg raises, twisting crunches</td>
<td>You typically don't stretch your abs. For most people, the abs are not strong enough, so you need to work on strengthening them rather than stretching them</td>
<td>The rectus abdominus is the muscle that is visible. The transversus abdominus muscle, which stabilizes your back, is underneath.</td>
</tr>
<tr>
<td>Biceps</td>
<td>Front of upper arm</td>
<td>Lifting, pulling</td>
<td>Bicep Curls</td>
<td>Sit on floor. Place hands behind you with fingers pointing away from your body. Walk your hips away from your hands.</td>
<td>Anytime you move your hand toward your shoulder, you are using your biceps.</td>
</tr>
<tr>
<td>Deltoids</td>
<td>Top of shoulder</td>
<td>Overhead lifting</td>
<td>Pushups, bench press, side &amp; rear arm raises</td>
<td>&quot;Scratch your Back&quot; - Put both hands over your head. Bend one elbow and place hand on back. With other hand, push elbow to stretch triceps, deltoids, lats</td>
<td>The deltoids are composed of three parts, anterior, posterior &amp; medial. Anytime you &quot;flap&quot; your arms, your deltoids are working.</td>
</tr>
<tr>
<td>Erector Spinae</td>
<td>Low back</td>
<td>Postural alignment</td>
<td>Back extensions</td>
<td>&quot;Cat Stretch&quot; - Kneel on all fours, round back like a cat. Sit on chair with feet shoulder distance apart. Bend over and place shoulders between your knees</td>
<td>The erector spinae is sometimes called the &quot;low back&quot; muscle, although it runs up your entire back.</td>
</tr>
<tr>
<td>Gastrocnemius &amp; Soleus</td>
<td>Back of lower leg</td>
<td>Push off for walking, standing on tiptoes</td>
<td>Standing calf raises, seated calf raises</td>
<td>Lunges with a straight back leg for gastrocnemius. Lunges with bent knees for soleus.</td>
<td>The gastrocnemius gives your legs a rounded shape. The soleus is underneath the gastrocnemius.</td>
</tr>
<tr>
<td>Gluteus</td>
<td>Buttocks</td>
<td>Climbing stairs, walking, standing up</td>
<td>Squat, leg press</td>
<td>Sit on chair, cross other leg over thigh of bent leg, lean forwards.</td>
<td>Made up of several muscles. The largest muscle in the body is the gluteus maximus.</td>
</tr>
<tr>
<td>Hamstrings</td>
<td>Thigh - back</td>
<td>Walking</td>
<td>Squats, lunges, leg extensions, leg curls</td>
<td>While standing, place heel of leg to be stretched on a chair. Keep your leg as straight as possible, your hips square and your back flat. Bend at the waist toward your leg.</td>
<td>The hamstrings are made up of three muscles. Don't squat below 90 degrees, otherwise you could damage your knees.</td>
</tr>
<tr>
<td>Latissimus Dorsi &amp; Rhomboids</td>
<td>Back - Lats are the large triangular muscle in the midback. Rhomboids are between the shoulder blades</td>
<td>Postural alignment, pulling open a door</td>
<td>Lats - pull ups, chin ups, lat pull downs Rhomboids - chinups &amp; bent arm rows</td>
<td>&quot;Scratch your Back&quot; - Put both hands over your head. Bend one elbow and place hand on back. With other hand, To stretch rhomboids, &quot;hug yourself&quot; Cross your hands in front of you, place both hands on your shoulder blades.</td>
<td>Developed lats give your back a &quot;V&quot; shape, making your waist appear smaller.</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------</td>
<td>-------------------------------</td>
<td>---------------------------------</td>
<td>------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Obliques</td>
<td>Side of body</td>
<td>Rotation and side flexion of body</td>
<td>Twisting crunches, rotary torso</td>
<td>Lie on your back with your arms extended out (&quot;T&quot; shape) Bend both knees. Rotate your hips and put your bent legs on the floor on your side.</td>
<td>Strong internal and external oblique muscles ward off back pain.</td>
</tr>
<tr>
<td>Pectoralis</td>
<td>Front of upper chest</td>
<td>Push up from lying position, push open a door</td>
<td>push-up, pull-up, bench press</td>
<td>While standing, hold both arms out at shoulder height, palms forward. Pull arms back.</td>
<td>The pectoralis muscles pull the shoulder and arm forward.</td>
</tr>
<tr>
<td>Quadriceps</td>
<td>Thigh - front</td>
<td>Climbing stairs, walking, standing up</td>
<td>Squats, lunges, leg presses</td>
<td>While lying on side, grasp ankle, push hips forward</td>
<td>The quads are made up of four muscles.</td>
</tr>
<tr>
<td>Trapezius</td>
<td>Large muscle in upper and mid-back.</td>
<td>Moves head sideways, upright rows, shoulder shrugs</td>
<td>Upper trap stretch. Sit in a chair; put your left hand behind you. Tilt your head so your right ear moves toward your right shoulder. Repeat on the other side.</td>
<td>Your upper trapezius connects your head to your shoulders. When you feel &quot;knots in your neck&quot;, it's your trapezius.</td>
<td></td>
</tr>
<tr>
<td>Triceps</td>
<td>Back of upper arm</td>
<td>Pushing</td>
<td>Pushups, tricep extensions, dips</td>
<td>&quot;Scratch your Back&quot; - Put both hands over your head. Bend one elbow and place hand on back. With other hand, push elbow to stretch triceps, deltoids, lats</td>
<td>Anytime you extend your lower arm, you are using your triceps</td>
</tr>
</tbody>
</table>
Experiment HM-9: Kinesiology and Electromyogram (EMG) Activity in Targeted Muscles

Lab written in conjunction with:
Kelly Helm PhD, Director Exercise Science, Department of Kinesiology;
Amanda Ulin & Kelsey Draper, Seniors, Biology & Exercise Science; Valparaiso University,
Valparaiso, IN
Jennifer Rosene PT, MS; Plymouth, NH

Equipment Required
PC or Mac Computer
IXTA data acquisition unit and USB cable
IXTA power supply
iWire-B3G ECG cable and electrode lead wires (optional – 2nd iWire-B3G)
Disposable electrodes
Alcohol swabs
Metronome
Chair
4 inch aerobic step

IXTA Setup
1. Place the IXTA on the bench, close to the computer.
2. Check Figure T-1-1 in the Tutorial Chapter for the location of the USB port and the power socket on the IXTA.
3. Check Figure T-1-2 in the Tutorial Chapter for a picture of the IXTA power supply.
4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA.
5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the power supply cable into the socket on the rear of the IXTA. Use the power switch to turn on the unit. Confirm that the power light is on.

Start the Software
1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is not available, click on the Windows Start menu, move the cursor to All Programs and then to the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window will appear as the program opens.
2. On the Main window, pull down the Settings menu and select Load Group.
3. Locate the folder that contains the settings group, IPLMv6Complete.iwxgrp. Select this group and click Open.

5. After a short time, LabScribe will appear on the computer screen as configured by the KinesiologyTargetedMuscles settings.

6. For your information, the settings used to configure the LabScribe software and the IXTA unit for this experiment are programmed on the Preferences Dialog window which can be viewed by selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the **Experiment** button on the toolbar to open any of the following documents:
   - Appendix
   - Background
   - Labs
   - Setup (opens automatically)

**Subject Attire:**

It is important that the subject wear loose comfortable clothing that allows for the attachment of seven (7) electrodes to the hip area. Bending, stretching, standing and lying down are all part of the exercise protocols that will be used. Comfortable, loose running shorts or pants are a good choice.

**EMG Cable Setup**

1. Locate the iWire-B3G EMG cable and electrode lead wires ([Figure HM-9-S1](#)) in the iWorx kit.

![Figure HM-9-S1: The iWire-B3G EMG cable with seven lead wires attached.](#)

**Note - Make sure to connect the iWire-B3G to the IXTA prior to turning it on.**

2. Insert the connector on the end of the EMG cable into the iWire 1 input on the front of the IXTA ([Figure HM-9-S2](#)).
Figure HM-9-S2: A seven lead EMG cable connected to an IXTA.

Figure HM-9-S3: Position of electrodes used to record EMG from muscles in the hip during various exercises.
3. Locate the muscles of the hip region over which the recording electrodes will be placed. Muscles can be located by flexing, extending, abducting and adducting the leg and noting the areas of the hip where the muscles are tense:

- One pair of recording electrodes will be placed over the **Tensor Fasciae Latae** muscle. The first electrode in this pair will be placed about 4 centimeters below the lateral edge of the anterior superior iliac spine. The second electrode in this pair will be placed about 2 centimeters below the other electrode along the midline of the Tensor muscle.

- The second pair of electrodes will be placed over the **Gluteus medius** muscle below the lateral edge of the iliac crest. The first electrode in this pair will be placed about 2 centimeters below the crest, at the midline of the leg. The second electrode in this pair will be placed about 2 centimeters just to the posterior of the first electrode. Make sure to stay on the Gluteus medius.

- The third pair of electrodes will be placed on the **Gluteus maximus** muscle. These two electrodes can be placed high on the Gluteus maximus, but below the iliac crest, so as not to interfere with clothing. Make sure the electrodes are at least 2-3 centimeters apart, on the ‘meaty’ portion of the upper Gluteus maximus. Avoid getting these electrodes on the medius.

- A seventh electrode, used as the ground, will be placed on the lower abdomen of whichever leg has been chosen for the electrode placement.

4. Use an alcohol swab to clean and scrub the areas where the electrodes will be placed (Figure HM-9-S3). Let the areas dry before attaching the electrodes.

5. Remove the plastic disk from a disposable electrode and apply it to one of the scrubbed areas. Attach an electrode to each of the other areas.

6. Snap the recording lead wires onto the electrodes, so that:

- the red “+1” lead is attached to the 1st electrode on the Tensor fasciae latae by the anterior superior iliac spine.
- the black “-1” lead is attached to the 2nd electrode on the Tensor fasciae latae.
- the white “+2” lead is attached to the 1st electrode lateral edge of the Gluteus medius.
- the brown “-2” lead is attached to the 2nd electrode on the lateral/posterior area of the Gluteus medius.
- the blue “+3” lead is attached to the 1st electrode on the upper posterior area of the Gluteus maximus.
- the yellow “-3” lead is attached to the 2nd electrode about 2-3 cm from the first electrode on the ‘meaty’ portion of the upper Gluteus maximus.
- the green “C” lead (the ground) is attached to the electrode in the center of the box formed by the positions of the four recording electrodes.
Experiment HM-9: Kinesiology and Electromyogram (EMG) Activity in Targeted Muscles

Lab written in conjunction with:
Kelly Helm PhD, Director Exercise Science, Department of Kinesiology;
Amanda Ulin & Kelsey Draper, Seniors, Biology & Exercise Science; Valparaiso University,
Valparaiso, IN
Jennifer Rosene PT, MS; Plymouth, NH

NOTE – Open the Appendix for diagrams and directions for all the muscle exercises to be used in this lab.

Exercise 1: Targeted Muscles and EMG Activity in the Hip

Aim: To study the EMG activity in specific targeted muscles that work in conjunction to strengthen the hip and gluteus muscles.

Procedure
1. Instruct the subject that he or she will be doing the following during this exercise:
   • Before the recording begins, the subject should read and understand all the exercises that need to be performed during this lab activity.
   • Make sure the subject has no known hip, lower back or knee injuries, issues or problems.
   • All exercises will be performed in the same manner.
     • Each exercise will be held for 4 seconds;
     • There will be a 4 second rest period between repetitions (reps);
     • Each exercise will be performed for 5 reps.
   • The metronome should be set appropriately for doing the exercises.

A. Bilateral Bridge

2. Before starting the recording, type the name of the first exercise, <Bilateral Bridge>, in the Mark box to the right of the Mark button. Instruct the subject to get into position to perform this exercise.
3. Click the Record button in the upper right corner of the LabScribe Main window. Either click on the Mark button or press the Enter key on the keyboard to label the recording.
4. As soon as the record button is clicked, have the subject complete 5 reps of the “Bilateral Bridge” exercise.
   • Make sure to engage core muscles and follow the directions as shown in the Appendix.
5. After the 4 second rest period after the 5th rep, click Stop to halt the recording.
6. Click AutoScale on all channels to show the complete EMG activity.
7. The recording should look similar to what is shown in Figure HM-9-L1.
Figure HM-9-L1: Muscle EMG activity as the subject is performing the bilateral bridge. Channels show the Tensor fasciae latae, Gluteus medius and Gluteus maximus muscles.

B. Standing Leg Abduction
   1. Repeat steps 2 – 5 above for Standing Leg Abduction.
   2. Click AutoScale on all channels to amplify signals. The recording should be similar to Figure HM-9-L2.
   3. Select Save As in the File menu, type a name for the file. Choose a destination on the computer in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click on the Save button to save the data file.

C. Forward Lunge
   1. Repeat steps 2 – 5 above for Forward Lunge.
   2. Click AutoScale on all channels to amplify signals.
   3. Click on the Save button to save the data file.
Figure HM-9-L2: Recordings from the three muscles while doing the Standing Leg Abduction.

D. Clam

1. Repeat steps 2 – 5 above for the Clam.
2. Click AutoScale on all channels to amplify signals. The recording should be similar to Figure HM-9-L3.
3. Click on the Save button to save the data file.

Figure HM-9-L3: Recording during the Clam exercise.
E. Squat
1. Repeat steps 2 – 5 above for the Clam.
2. Click AutoScale on all channels to amplify signals.
3. Click on the Save button to save the data file.

F. Side-Step
1. Repeat steps 2 – 5 above for the Side-Step.
2. Click AutoScale on all channels to amplify signals.
3. Click on the Save button to save the data file.

G. Standing Hip Extension – Knee Extended
1. Repeat steps from above for the Standing Hip Extension.
2. Click AutoScale on all channels to amplify signals. The recording should be similar to Figure HM-9-L4.
3. Click on the Save button to save the data file.

H. Standing Hip Extension – Knee Flexed
1. Repeat steps from above for the Standing Hip Extension.
2. Click AutoScale on all channels to amplify signals.
3. Click on the Save button to save the data file.

Figure HM-9-L4: Standing Hip Extension – Knee Extended
I. Forward Step Up  
1. Repeat steps from above for the Forward Step-Up.  
2. Click AutoScale on all channels to amplify signals. The recording should be similar to Figure HM-9-L5.  
3. Click on the Save button to save the data file. 

![Figure HM-9-L5: Forward Step Up](Image)

J. Standing Hip Hike  
1. Repeat steps from above for the Standing Hip Hike.  
2. Click AutoScale on all channels to amplify signals.  
3. Click on the Save button to save the data file. 

Data Analysis  
1. Scroll through the recording and find the first complete section of data recorded while the subject was doing the Bilateral Bridge.  
2. Use the Display Time icons to adjust the Display Time of the Main window so all 5 reps appear on the Main window. The five reps can also be selected by:  
   - Placing the cursors on either side of the 5 repetitions; and  
   - Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the segment with the three cycles to the width of the Main window.  
3. Click on the Analysis window icon in the LabScribe toolbar (Figure HM-9-L6) or select Analysis from the Windows menu to transfer the data displayed in the Main window to the Analysis window (Figure HM-9-L7).
4. Look at the Function Table that is above the uppermost channel displayed in the Analysis window. The mathematical functions, Abs. Int. and T2-T1 should appear in this table. The values for Abs. Int. and T2-T1 for each muscle are seen in the table across the top margin of each channel.

5. Click and drag the cursors to be on either side of one EMG contraction on the Tensor fasciae latae muscle. Place them to they are **exactly** 4 seconds apart.
   - Use the right and left arrow keys to get the cursors exactly 4 seconds apart, after you have moved them to the location surrounding the EMG activity.
   - Click Tools
   - Choose “Lock Cursor Separation” to lock the cursors to a 4 second interval.

6. Once the cursors are placed and locked for measuring the first EMG burst, the values for the parameters can be recorded in the on-line notebook of LabScribe by typing the names and values directly into the Journal, or on a data table.

7. The functions in the channel pull-down menus of the Analysis window can also be used to enter the names and values of the parameters to the Journal. To use these functions:
   - Place the cursors at the locations used to measure the absolute integrals as above.
   - Transfer the name of the mathematical function used to determine the absolute integrals to the Journal using the Add Title to Journal function in the Anterior Channel pull-down menu.
   - Transfer the values for the absolute integrals to the Journal using the Add All Data to Journal function in the Anterior Channel pull-down menu.
Figure HM-9-L7: EMG activity from the Tensor fasciae latae, Gluteus medius and Gluteus maximus muscles. Cursors are placed exactly 4 seconds apart to measure the EMG activity taking place simultaneously in the three muscles. The muscle with the highest activity is the muscle firing the strongest.

8. The values for Abs. Int. and T2-T1 on the channels are the relative amounts of the EMG activity and the 4 second duration during which the EMG burst occurred.

9. Record the values from each muscle group during the first EMG burst in the Journal, or on a data table.

10. Use the mouse to move the cursors to onset and offset of the next EMG burst and measure and record the values for Abs. Int. and T2-T1 from the muscles.

11. Measure the Abs. Int and T2-T1 for the EMG bursts from the three muscles for the remaining three repetitions.

12. Average the values for the Abs. Int. taken from the muscles during the exercise. Enter the averages for each muscle during the first exercise on Table HM-9-L1.

13. Select Save from the File menu.

Note – You may need to “unlock” cursor separation to continue the lab and “relock” when performing data analysis.

Exercise 2: EMG Activity in other Targeted Muscle Sites

Aim: To study the EMG activity in other targeted muscle groups.

Procedure

1. Use the same experimental setup used in Exercise 1.

2. Choose a different group of muscles to use:
• Quadriceps: use the Vastus lateralis, Vastus medialis and Rectus femoris
• Hamstrings: use the Semimembranosus, Semitendinosus and Biceps femoris
• Shoulder: use the Deltoid, Biceps brachii and Triceps brachii

Data Analysis
1. Use the same procedures used in Exercise 1 to measure and record the Abs. Int. and T2-T1 from each muscle when using a different targeted muscle groups.

Questions
1. What muscles are activated during each of the exercises?
2. Can the muscles be “trained” to work the target muscle without involving the other muscles of the selected group?
   • If so, how would you go about making sure the targeted muscle is the one that is firing during a certain exercise?
3. If other muscles besides the targeted muscle are involved during an activity, how can you tell which muscle is doing the majority of the activity?

Optional Exercises
Using the 2nd iWire-B3G
• Test the subject bilaterally
• Choose an additional 3 muscles to test at the same time
  • an example: test both the quads and hamstrings simultaneously

Table HM-9-L1: Relative EMG Activity in the Hip Muscles during a variety of exercises.

<table>
<thead>
<tr>
<th>Action</th>
<th>Averages from Tensor fasciae latae</th>
<th>Averages from Gluteus medius</th>
<th>Averages from Gluteus maximus</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Abs.Int.</td>
<td>T2-T1 (sec)</td>
<td>Abs.Int.</td>
</tr>
<tr>
<td>Bilateral Bridge</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standing Leg Abduction</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward Lunge</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clam</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Squat</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exercise</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Side Step Up</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Leg Extension – Knee Extended</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Leg Extension – Knee Flexed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward Step Up</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standing Hip Hike</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>